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Μηχανή Χάραξης Λέιζερ 10W 



Μέρος 1: Δήλωση Ασφαλείας Πριν την Εγκατάσταση 
Πριν χρησιμοποιήσετε το μηχάνημα χάραξης λέιζερ, παρακαλούμε διαβάστε 
προσεκτικά αυτόν τον οδηγό ασφαλείας. Περιέχει πληροφορίες σχετικά με 
καταστάσεις που απαιτούν ειδική προσοχή, καθώς και προειδοποιήσεις για μη 
ασφαλείς πρακτικές που μπορεί να προκαλέσουν ζημιά στην περιουσία σας ή 
ακόμη και να θέσουν σε κίνδυνο την προσωπική σας ασφάλεια. 

1. Το προϊόν ανήκει στην κατηγορία λέιζερ Class 4. Το σύστημα λέιζερ 
πρέπει να πληροί τις απαιτήσεις του IEC 60825-1 τελευταίας έκδοσης, 
διαφορετικά απαγορεύεται η χρήση του προϊόντος. 

2. Αν το προστατευτικό περίβλημα διαθέτει θύρα πρόσβασης που επιτρέπει 
«είσοδο πεζού», τότε: 
a) Πρέπει να υπάρχουν μέτρα ώστε οποιοδήποτε άτομο μέσα στο 
προστατευτικό περίβλημα να μπορεί να αποτρέψει την ενεργοποίηση 
κινδύνου λέιζερ αντίστοιχου με Class 3B ή Class 4. 
b) Πρέπει να υπάρχει συσκευή προειδοποίησης που θα εξασφαλίζει 
επαρκή προειδοποίηση εκπομπής ακτινοβολίας λέιζερ ισοδύναμης με 
Class 3R, στο εύρος μήκους κύματος πάνω από 400 nm και πάνω από 700 
nm, ή ακτινοβολίας αντίστοιχης με Class 3B ή Class 4 για οποιοδήποτε 
άτομο βρίσκεται μέσα στο προστατευτικό περίβλημα. 
c) Όπου η πρόσβαση σε χώρο κατά τη λειτουργία είναι πιθανή ή 
αναμενόμενη, η εκπομπή ακτινοβολίας λέιζερ αντίστοιχης με Class 3B ή 
Class 4 ενώ υπάρχει άτομο μέσα στο προστατευτικό περίβλημα ενός 
προϊόντος Class 1, Class 2 ή Class 3R πρέπει να αποτρέπεται με μηχανικά 
μέσα. 

Σημείωση: 
Μέθοδοι αποτροπής έκθεσης ανθρώπων σε ακτινοβολία όταν βρίσκονται μέσα 
στο προστατευτικό περίβλημα μπορεί να περιλαμβάνουν ευαίσθητα δάπεδα 
πίεσης, υπέρυθρους ανιχνευτές κ.λπ. 

 
3. Το ίδιο το λέιζερ έχει προστατευτικό κάλυμμα. Το κάλυμμα αυτό 

στερεώνεται με βίδες ή μαγνήτες. Όταν το λέιζερ είναι εγκατεστημένο 
στον χαράκτη λέιζερ, το προστατευτικό κάλυμμα πρέπει να ελέγχεται ότι 
έχει ασφαλίσει σωστά και δεν μπορεί να αφαιρεθεί ενώ το σύστημα είναι 
ενεργοποιημένο. 

4. Ο χαράκτης λέιζερ διαθέτει κουμπί επαναφοράς (reset), το οποίο μπορεί 
να επανεκκινήσει την εργασία αφού πρώτα βεβαιωθεί η ασφάλεια μέσω 
διακόπτη interlock ή κουμπιού έκτακτης ανάγκης. 

5. Τοποθετήστε μια προειδοποιητική πινακίδα σε οποιοδήποτε παράθυρο ή 
κανάλι που μπορεί να βλέπει ή να εκτίθεται παθητικά σε ακτινοβολία του 
λέιζερ κατά τη λειτουργία. 

6. Αν το λέιζερ προκαλέσει έγκαυμα στο δέρμα ή στα μάτια, πηγαίνετε άμεσα 
σε νοσοκομείο για εξέταση και θεραπεία. 

 
 
 
 
 



Μέρος 2: Δήλωση Ασφαλείας Χρήστη 
Το φως λέιζερ μπορεί να προκαλέσει βλάβη στα μάτια και στο δέρμα. 
ΜΗΝ εκθέτετε τα μάτια ή το δέρμα σας απευθείας στη δέσμη λέιζερ. 
Το προϊόν αυτό εκπέμπει μια συγκεντρωμένη δέσμη λέιζερ μέσω οπτικού 
φακού. 
Το φως που εκπέμπεται από το προϊόν, είτε είναι άμεσο είτε αντανακλώμενο, 
μπορεί να προκαλέσει σοβαρά εγκαύματα ή μόνιμη βλάβη στην όραση. 
Κατά τη χρήση του προϊόντος, είναι απαραίτητο να φοράτε κατάλληλα 
προστατευτικά γυαλιά (OD5+) για προστασία από τη δέσμη λέιζερ και τη 
σκέδαση φωτός. 
Ποτέ μην κοιτάτε άμεσα το λέιζερ ενώ λειτουργεί. 
Το αντανακλώμενο φως λέιζερ μπορεί επίσης να προκαλέσει τραυματισμό. 

 
2.1 Ασφάλεια λέιζερ 

• Έχουμε τοποθετήσει προστατευτική ασπίδα στο λέιζερ, η οποία φιλτράρει 
το μεγαλύτερο μέρος της σκέδασης φωτός. 

• Όταν χρησιμοποιείτε το μηχάνημα χάραξης λέιζερ, συνιστάται να φοράτε 
εγκεκριμένα προστατευτικά γυαλιά λέιζερ για επιπλέον ασφάλεια. 

• Αποφύγετε την έκθεση του δέρματος σε δέσμες λέιζερ, ειδικά σε κοντινές 
αποστάσεις. 

• Έφηβοι και νέοι πρέπει να χρησιμοποιούν τη συσκευή μόνο υπό επίβλεψη 
ενηλίκων. 

• Μην αγγίζετε τη μονάδα χάραξης όταν το μηχάνημα λειτουργεί. 
 

2.2 Ασφάλεια πυρός 
Η αφαίρεση υλικού μέσω χάραξης ή κοπής λέιζερ δημιουργεί υψηλή θερμότητα. 
Ένα λέιζερ υψηλής έντασης μπορεί να: 

• καίει την επιφάνεια του υλικού, 
• προκαλεί φλόγα, 
• αναφλέγει εύφλεκτα σωματίδια και σκόνη. 

Ορισμένα υλικά παράγουν σπινθήρες ή φλόγα κατά τη χάραξη και μπορεί να 
προκαλέσουν φωτιά μέσα στο μηχάνημα. 
Μία μικρή φλόγα μπορεί να εμφανιστεί όταν το λέιζερ καίει το υλικό – αυτό δεν 
είναι ασυνήθιστο. 
ΜΗΝ αφήνετε το μηχάνημα χωρίς επίβλεψη κατά τη διάρκεια της χρήσης. 
Μετά τη χρήση: 

• Απομακρύνετε υπολείμματα, σκόνη και εύφλεκτα υλικά από την επιφάνεια 
εργασίας. 

• Διατηρείτε τον χώρο καθαρό ώστε να μειωθεί ο κίνδυνος πυρκαγιάς. 
• Όταν τα μηχανήματα λέιζερ κόβουν υλικά όπως ξύλο, ακρυλικό, πλαστικό 

ή άλλα οργανικά υλικά, 
παράγονται θερμά αέρια, καπνοί και πιθανώς τοξικές ουσίες. 

Οι καπνοί και οι ρύποι αυτοί μπορεί να είναι επικίνδυνοι για την υγεία. 
 
 
 

 



2.3 Ασφάλεια υλικών 
Μην χαράζετε υλικά άγνωστης σύστασης. 
Συνιστώμενα υλικά: 

• ξύλο 
• μπαμπού 
• δέρμα 
• πλαστικό 
• ύφασμα 
• χαρτί 
• χαρτόνι 
• ακρυλικό 

Μη συνιστώμενα υλικά: 
• γυαλί 
• ατσάλι (εκτός αν υποστηρίζεται από το συγκεκριμένο λέιζερ) 
• επιστρώσεις χρωμίου 
• PVC 
• απομίμηση δέρματος 
• πολυεστέρας 
• επιφάνειες με καθρέπτη 
• ανακλαστικά υλικά 

     Εάν χρησιμοποιείτε ανακλαστικά υλικά 
→ Συνιστάται να τα βάψετε με μαύρο ματ χρώμα για να μειωθεί η αντανάκλαση. 

 
2.4 Ασφάλεια χρήσης 

• Το λέιζερ πρέπει να λειτουργεί σε επίπεδη και σταθερή επιφάνεια. 
• Μην το χρησιμοποιείτε σε κεκλιμένη ή ασταθή επιφάνεια. 
• Κρατήστε τα χέρια σας μακριά από τη δέσμη. 
• Μην αγγίζετε το μηχάνημα κατά την κίνηση της κεφαλής χάραξης. 
• Μην επιτρέπετε σε παιδιά να πλησιάζουν το μηχάνημα ενώ λειτουργεί. 

 
2.5 Ασφάλεια ισχύος 
Για να αποτραπούν ατυχήματα όπως ηλεκτροπληξία, το λέιζερ πρέπει: 

• να είναι συνδεδεμένο σε πρίζα με γείωση, 
• να χρησιμοποιείται αποκλειστικά με το παρεχόμενο καλώδιο ρεύματος, 
• να αποσυνδέεται πάντα πριν από συντήρηση ή μετακίνηση. 

Κατά τη χρήση του Laser Engraver: 
• Μην αγγίζετε την κεφαλή του λέιζερ όταν είναι ενεργή. 
• Αντικαταστήστε καλώδια που έχουν φθορά ή ζημιά. 

 
2.6 Ασφάλεια περιβάλλοντος 

• Κατά τη χρήση εξοπλισμού χάραξης/κοπής, βεβαιωθείτε ότι ο χώρος είναι 
καλά αεριζόμενος. 

• Τα παραγόμενα καπναέρια μπορεί να είναι εύφλεκτα ή τοξικά. 
• Τοποθετήστε μεταλλική πλάκα ή προστατευτικό κάτω από το υλικό για να 

αποτρέψετε ανάφλεξη. 
 
 



Μέρος 3: Αποποίηση Ευθύνης και Προειδοποίηση 
Το προϊόν αυτό δεν είναι παιχνίδι και δεν είναι κατάλληλο για άτομα κάτω των 16 
ετών. 
Μην επιτρέπετε σε παιδιά να αγγίζουν το λέιζερ. 
Να είστε ιδιαίτερα προσεκτικοί όταν λειτουργείτε σε χώρους με παιδιά. 
Το προϊόν αυτό είναι μονάδα λέιζερ. Παρακαλούμε διαβάστε το εγχειρίδιο 
λειτουργίας για τις σχετικές οδηγίες. Η VEVOR διατηρεί το δικαίωμα να 
ενημερώνει αυτήν την αποποίηση ευθύνης και τον οδηγό ασφαλείας ανά πάσα 
στιγμή. 
Παρακαλούμε διαβάστε προσεκτικά αυτό το έγγραφο πριν χρησιμοποιήσετε το 
προϊόν για να κατανοήσετε τις νομικές σας υποχρεώσεις και τις οδηγίες 
ασφαλείας. 
Διαφορετικά, μπορεί να προκύψουν: 

• βλάβη προϊόντος, 
• απώλεια προσωπικών αντικειμένων, 
• τραυματισμός, 
• ακόμα και σοβαρός κίνδυνος για τη ζωή. 

Αν δεν αποδεχτείτε αυτούς τους κανόνες, μην χρησιμοποιείτε το προϊόν. 
Η χρήση του προϊόντος δηλώνει ότι έχετε κατανοήσει και αποδεχτεί τις οδηγίες 
και ότι αναλαμβάνετε πλήρως την ευθύνη για δικές σας πράξεις και συνέπειες. 
Ο χρήστης συμφωνεί να χρησιμοποιεί το προϊόν μόνο για νόμιμους σκοπούς και 
αποδέχεται τους όρους του εγγράφου αυτού και κάθε άλλου σχετικού εγγράφου 
που παρέχει η VEVOR. 
Κατανοείτε επίσης ότι η VEVOR μπορεί να μην είναι σε θέση να σας παρέχει 
υποστήριξη εάν: 

• το προϊόν έχει τροποποιηθεί, 
• έχει γίνει μη εξουσιοδοτημένη επισκευή, 
• έχουν προστεθεί μη εγκεκριμένα εξαρτήματα, 
• έχετε χρησιμοποιήσει το προϊόν με τρόπο αντίθετο στις οδηγίες. 

Οποιαδήποτε ζημιά συμβεί λόγω ανάρμοστης χρήσης ή λανθασμένης 
εγκατάστασης αποτελεί ευθύνη του χρήστη. 
Η VEVOR δεν ευθύνεται για βλάβες ή απώλειες που προκύπτουν από: 

• αποτυχία του χρήστη να ακολουθήσει το εγχειρίδιο, 
• αφαίρεση ή αποσυναρμολόγηση του εξοπλισμού χωρίς άδεια τεχνικού 

προσωπικού της εταιρείας. 
Η VEVOR έχει το δικαίωμα τελικής ερμηνείας του εγγράφου αυτού, υπό την 
επιφύλαξη των εφαρμοστέων νόμων. 
Η VEVOR διατηρεί το δικαίωμα να ενημερώσει, τροποποιήσει ή τερματίσει τους 
όρους χωρίς προηγούμενη ειδοποίηση. 
 
 
 
 
 
 
 

 



Μέρος 4: Βήματα Εγκατάστασης 
Βήμα 1: Συναρμολόγηση του σκελετού 
(Με βάση το σχέδιο που φαίνεται στην εικόνα – δεν μπορώ να αλλάξω το 
διάγραμμα, αλλά μεταφράζω πλήρως την περιγραφή) 

• Συνδέστε τα τέσσερα κάθετα/οριζόντια τμήματα χρησιμοποιώντας τα 
εξαρτήματα M5X25 και M5X35 σύμφωνα με το διάγραμμα. 

• Βεβαιωθείτε ότι όλες οι βίδες είναι σφιγμένες και ότι ο σκελετός είναι 
τετράγωνος και σταθερός. 

Βήμα 2: Συναρμολόγηση του υποστηρικτικού ποδιού και της αλυσίδας του 
άξονα Ζ 

• Χρησιμοποιήστε τα εξαρτήματα M5X14, M5X44, M5X35, σύμφωνα με το 
διάγραμμα. 

• Μετά τη συναρμολόγηση, ελέγξτε ότι τα δύο δεξιά πόδια και η δεξιά 
κάθετη ράγα είναι ευθυγραμμισμένα. 

• Εάν υπάρχει απόκλιση, χαλαρώστε ελαφρώς τις βίδες, ευθυγραμμίστε 
ξανά και ξανασφίξτε 

 
Βήμα 4: Εγκατάσταση του οπτικού άξονα και ρύθμιση του εκκεντρικού 
τροχού 
Ακολουθήστε το διάγραμμα για να τοποθετήσετε το συγκρότημα του οπτικού 
άξονα επάνω στον σκελετό. 
Ο οπτικός άξονας πρέπει να τοποθετηθεί ομοιόμορφα έτσι ώστε το συγκρότημα 
να κινείται ομαλά κατά μήκος των ραγών. 
Ρυθμίστε τον εκκεντρικό τροχό ώστε: 

• να μην υπάρχει υπερβολικό κενό, 
• αλλά ούτε και υπερβολική πίεση στους τροχούς κύλισης. 

4 μικρά διαγράμματα δείχνουν: 
1. Σωστή επαφή τροχού με ράγα 
2. Εσφαλμένη γωνία τροχού 
3. Οπτική ευθυγράμμιση στο 45° 
4. Ορθή πίεση επαφής 

 
ΣΥΜΒΟΥΛΗ (TIPS): Πώς να καθορίσετε τη σωστή σύσφιξη του εκκεντρικού 
τροχού 
Για να ελέγξετε εάν το σφίξιμο είναι σωστό: 

• Πιάστε το ένα άκρο του μηχανήματος και σηκώστε το υπό γωνία περίπου 
45°. 

• Ελέγξτε εάν το συγκρότημα του οπτικού άξονα (X-axis) γλιστράει 
ελεύθερα κατά μήκος της ράγας. 

• Αν γλιστράει πολύ εύκολα → ο τροχός είναι πολύ χαλαρός. 
• Αν δεν κινείται καθόλου ή κολλάει → ο τροχός είναι πολύ σφιχτός. 
• Ο στόχος είναι να μπορεί το μπράτσο να κινείται σταθερά αλλά χωρίς 

τζόγο. 
 
 
 

 



Βήμα 5: Εγκατάσταση του Λέιζερ 
Ακολουθήστε το διάγραμμα για να τοποθετήσετε το λέιζερ στο κινούμενο άξονα. 

• Χρησιμοποιήστε τα εξαρτήματα M4X8 (2 τεμάχια) για να στερεώσετε τη 
βάση του λέιζερ. 

• Χρησιμοποιήστε περικόχλια M4 (2 τεμάχια) για να ασφαλίσετε το λέιζερ 
επάνω στη βάση. 

Βήμα προς βήμα: 
1. Ευθυγραμμίστε το σώμα του λέιζερ με τις οπές της βάσης. 
2. Τοποθετήστε τις βίδες M4X8. 
3. Σφίξτε τα παξιμάδια M4 στο πίσω μέρος. 
4. Βεβαιωθείτε ότι το λέιζερ έχει τοποθετηθεί σε ευθεία θέση πάνω από τον 

άξονα εργασίας. 
5. Το τελικό διάγραμμα δείχνει το λέιζερ πλήρως εγκατεστημένο επάνω στο 

πλαίσιο 
 

 
 
 
 
 
 
 



Βήμα 6: Εγκατάσταση του καλωδίου 
Ακολουθήστε τα διαγράμματα για τη σωστή σύνδεση των καλωδίων στον 
χαράκτη λέιζερ. 

1. Συνδέστε τον ακροδέκτη του μοτέρ Χ (X-axis motor). 
Ο σύνδεσμος πρέπει να κουμπώσει σταθερά στη θέση του. 

2. Συνδέστε τον ακροδέκτη του μοτέρ Υ (Y-axis motor). 
3. Συνδέστε το καλώδιο του λέιζερ. 

Η υποδοχή του λέιζερ βρίσκεται στο επάνω μέρος της μονάδας του λέιζερ. 
4. Στερεώστε τα καλώδια στις ράγες ώστε να μην πιαστούν κατά την 

κίνηση του άξονα. 
 

Σημαντική οδηγία πριν ενεργοποιήσετε το λέιζερ 
Πριν ανοίξετε το μηχάνημα: 

• Βεβαιωθείτε ότι η κεφαλή του λέιζερ βρίσκεται στο κέντρο του άξονα 
X, όπως δείχνει το διάγραμμα. 

• Τοποθετήστε σωστά το καλώδιο του λέιζερ και ελέγξτε ότι δεν εμποδίζει 
την κίνηση. 

Το διάγραμμα δείχνει: 
• 3 σημεία σύνδεσης καλωδίων (μοτέρ, λέιζερ, τροφοδοσία). 
• Υποδείξεις για τον σωστό τρόπο δρομολόγησης των καλωδίων. 
• Κοντινές εικόνες που δείχνουν πού κουμπώνουν οι σύνδεσμοι (1, 2, 3). 

 
Βήμα 7: Ρύθμιση της θέσης του οριακού διακόπτη του άξονα Υ (Y-axis limit 
switch) 
Για λέιζερ διαφορετικής ισχύος (watt), είναι απαραίτητο: 

• να ρυθμίσετε ξανά τη θέση του limit switch στο άξονα Υ, 
• ώστε η κεφαλή του λέιζερ να μπορεί να μετακινηθεί πλήρως χωρίς να 

χτυπήσει στα άκρα. 
Το διάγραμμα δείχνει: 

• την κανονική θέση του limit switch, 
• και τη νέα θέση που απαιτείται για άλλο μέγεθος/βάρος λέιζερ. 

Ο οριακός διακόπτης: 
• ενεργοποιεί το σύστημα όταν η κεφαλή φτάσει στο μηδενικό σημείο, 
• προστατεύει από συγκρούσεις, 
• πρέπει να είναι σωστά ευθυγραμμισμένος με το κινούμενο μπλοκ του 

άξονα Υ. 
 
 

 
 



Μέρος 5: Περιγραφή του κουτιού ελέγχου (Control Box) 
Σύμφωνα με το διάγραμμα, το κουτί ελέγχου περιλαμβάνει: 

1. Διακόπτης τροφοδοσίας (Power switch): 
Ελέγχει την ενεργοποίηση και απενεργοποίηση της συσκευής. 

2. Υποδοχές τροφοδοσίας (Power socket): 
o DC 12V παροχή (Α7) 
o DC 24V παροχή (G3) 

3. Θύρα USB (USB interface): 
Ελέγχει τον χαράκτη λέιζερ από τον υπολογιστή όταν συνδέεστε με 
καλώδιο USB. 

4. Κουμπί επαναφοράς (Reset switch): 
Χρησιμοποιείται όταν παρουσιαστεί κατάσταση έκτακτης ανάγκης ή όταν 
το μηχάνημα κολλήσει. 
Με το κουμπί επαναφοράς γίνεται επανεκκίνηση του χαράκτη. 

     Προειδοποίηση: 
Μην αφήνετε τα καλώδια να αγγίζουν το μηχάνημα κατά τη διάρκεια της 
λειτουργίας του λέιζερ. 

 
Οδηγίες εξαγωγής αρχείων nc και gc 
Αυτές οι οδηγίες αφορούν τη δημιουργία G-code για χρήση με τον χαράκτη 
λέιζερ. 

 
1. Λογισμικό LaserGRBL 

1. Εισαγάγετε την εικόνα που θέλετε να χαράξετε ή να κόψετε στο 
LaserGRBL. 
Μετά τη ρύθμιση της ταχύτητας χάραξης, της ισχύος και των παραμέτρων 
ενέργειας, 
κάντε κλικ στο "File" και στη συνέχεια επιλέξτε "Quick Save". 

2. Αποθηκεύστε το αρχείο για να δημιουργήσετε το .nc αρχείο. 
 

2. Λογισμικό LightBurn 
1. Εισαγάγετε την εικόνα που θα χαραχτεί ή θα κοπεί στο LightBurn. 

Ρυθμίστε την ταχύτητα, την ισχύ και τις υπόλοιπες παραμέτρους χάραξης. 
Στη συνέχεια κάντε κλικ στο "Save GCode". 

2. Αποθηκεύστε το αρχείο για να δημιουργήσετε το .gc αρχείο. 
 
 
Μέρος 6: Εγκατάσταση και χρήση λογισμικού 

1. Λήψη του λογισμικού LaserGRBL 
2. Εγκατάσταση του LaserGRBL 
3. Προσθήκη προσαρμοσμένων κουμπιών 
4. Σύνδεση του μηχανήματος χάραξης λέιζερ 
5. Ρύθμιση παραμέτρων χάραξης 
6. Ρύθμιση εστίασης λέιζερ 
7. Τοποθέτηση (Positioning) 
8. Έναρξη, τερματισμός, χάραξη ή κοπή 
9. Οδηγός εγκατάστασης LightBurn 



 
1. Λήψη του λογισμικού LaserGRBL 
Το LaserGRBL είναι ένα από τα πιο δημοφιλή λογισμικά DIY χάραξης λέιζερ. 
Μπορείτε να το κατεβάσετε από την επίσημη ιστοσελίδα: 
     http://lasergrbl.com/download/ 

 
2. Εγκατάσταση του LaserGRBL 

• Κάντε διπλό κλικ στο αρχείο εγκατάστασης για να ξεκινήσει η διαδικασία. 
• Ακολουθήστε τα βήματα εγκατάστασης μέχρι να ολοκληρωθεί. 

(Η εικόνα στο εγχειρίδιο δείχνει το παράθυρο εγκατάστασης του LaserGRBL.) 
 

3. Προσθήκη προσαρμοσμένων κουμπιών (Custom Buttons) 
Το LaserGRBL επιτρέπει την προσθήκη κουμπιών για αυτοματοποιημένες 
εντολές, όπως: 

• ρύθμιση εστίασης, 
• μετακίνηση άξονα, 
• εντολές G-code κ.λπ. 

Βήμα 1 – Εγκατάσταση προτύπων κουμπιών 
Μπορείτε να κατεβάσετε το πακέτο κουμπιών από το LaserGRBL: 
     Επιλέξτε: 
LaserGRBL → Custom → Custom Buttons → Download 
Το αρχείο περιέχει μια σειρά έτοιμων κουμπιών. 
Το κουμπί που θα προστεθεί εμφανίζεται όπως φαίνεται στην εικόνα ("Picture1"). 

 
Βήμα 2 – Προσθήκη του κουμπιού στο LaserGRBL 

1. Ανοίξτε το LaserGRBL. 
2. Επιλέξτε Custom Buttons. 
3. Κάντε δεξί κλικ στον κενό χώρο. 
4. Επιλέξτε "Add Custom Button". 
5. Στο μενού που θα ανοίξει, εντοπίστε το κουμπί που κατεβάσατε. 
6. Επιλέξτε το και πατήστε OK. 

Το κουμπί θα προστεθεί στη γραμμή κουμπιών. 
(Οι εικόνες Picture 2–4 δείχνουν τα μενού και τη διαδικασία προσθήκης.) 
 
4. Σύνδεση του μηχανήματος χάραξης λέιζερ 
A. Συνδέστε τον χαράκτη λέιζερ στον υπολογιστή όπου είναι εγκατεστημένο το 
λογισμικό LaserGRBL. 
B. Συνδέστε την τροφοδοσία του μηχανήματος. 
C. Ανοίξτε το LaserGRBL. 
D. Στο επάνω αριστερό μέρος της οθόνης, επιλέξτε τη σωστή θύρα επικοινωνίας 
(COM). 
Σημείωση: 

• Η προεπιλεγμένη ταχύτητα σειριακής πόρτας είναι 115200. 
• Αν υπάρχουν πολλές θύρες COM και δεν γνωρίζετε ποια είναι η σωστή, 

αποσυνδέστε το καλώδιο USB και δείτε ποια θύρα εξαφανίζεται από τη 
λίστα. 

• Στη συνέχεια ξανασυνδέστε και επιλέξτε τη θύρα που εμφανίζεται ξανά. 



Το διάγραμμα δείχνει πού βρίσκεται η επιλογή της θύρας (port number). 
 

E. Εγκατάσταση του οδηγού CH340 (driver) 
• Στο LaserGRBL, κάντε κλικ στο "Tools" → "Install CH340 Driver". 
• Μετά την εγκατάσταση, κάντε επανεκκίνηση του υπολογιστή. 

Όταν ολοκληρωθεί: 
• Κάντε κλικ στο εικονίδιο σύνδεσης (κεραυνός). 
• Αν το εικονίδιο γίνει κόκκινο, η σύνδεση ήταν επιτυχής. 

(Η εικόνα δείχνει το πράσινο → κόκκινο εικονίδιο σύνδεσης και το παράθυρο του 
LaserGRBL.) 

 
G. Εάν ο υπολογιστής και ο χαράκτης λέιζερ δεν συνδέονται αρχικά 
Τότε πρέπει να ενημερώσετε (update) τον driver: 

1. Στο LaserGRBL, κάντε κλικ στο "Tools" → "Run LaserGRBL Driver 
Update". 

2. Επανεκκινήστε τον υπολογιστή μετά την ενημέρωση. 
3. Ξανασυνδέστε το USB και δοκιμάστε ξανά τη σύνδεση, όπως φαίνεται στο 

διάγραμμα. 
Το εγχειρίδιο δείχνει: 

• Μήνυμα «installation» 
• Επανεμφάνιση της θύρας COM 
• Επιτυχής σύνδεση (κόκκινο εικονίδιο) 

 
5. Ρύθμιση παραμέτρων χάραξης 

1. Επιλέξτε το αρχείο προς χάραξη. 
2. Στο LaserGRBL, κάντε κλικ στο "File" → "Open File" και επιλέξτε την 

εικόνα που θέλετε να χαράξετε. 
3. Το LaserGRBL υποστηρίζει εικόνες PNG, BMP, JPG, DXF και άλλες μορφές. 

 
5. Ρύθμιση παραμέτρων χάραξης 
1. Επιλογή του αρχείου για χάραξη 
Ανοίξτε το LaserGRBL → κάντε κλικ στο “File” → “Open File” και επιλέξτε την 
εικόνα που θέλετε να χαράξετε. 
Το LaserGRBL υποστηρίζει μορφές όπως: 

• NC, BMP, JPG, PNG, DXF, και άλλες. 
(Στην εικόνα εμφανίζεται το παράθυρο “Open File”.) 

 
2. Ρύθμιση εικόνας, λειτουργίας χάραξης και ποιότητας χάραξης 
Στο LaserGRBL μπορείτε να ρυθμίσετε: 

• ευκρίνεια (sharpness) 
• φωτεινότητα (brightness) 
• αντίθεση (contrast) 
• σκιά (highlight) 
• άλλες παραμέτρους εικόνας 

Όταν προσαρμόζετε τις παραμέτρους της εικόνας: 
• Το αποτέλεσμα εμφανίζεται στο παράθυρο προεπισκόπησης. 
• Μπορείτε να επιλέξετε “line to line tracking” ή “fill dithering”. 



• Διαφορετικές μέθοδοι είναι κατάλληλες για διαφορετικά είδη εικόνων. 
     Αν πρόκειται να κόψετε, επιλέξτε λειτουργία που παράγει γραμμές υψηλής 
ποιότητας. 
     Αν πρόκειται να χαράξετε, επιλέξτε μέθοδο με πιο λεπτομερή επεξεργασία. 
Σχετικά με τη φωτεινότητα του λέιζερ 
Η φωτεινότητα / ισχύς του λέιζερ διαφέρει ανάλογα με το υλικό, οπότε οι τιμές 
πρέπει να προσαρμόζονται ανάλογα. 
Επιπλέον λειτουργίες επεξεργασίας 
Στο κάτω μέρος του παραθύρου προεπισκόπησης: 

• μπορείτε να περιστρέψετε την εικόνα, 
• να δημιουργήσετε mirror, 
• να ορίσετε κατεύθυνση χάραξης, 
• ή να επεξεργαστείτε τμήματα της εικόνας. 

 
3. Ρύθμιση ταχύτητας χάραξης, ενέργειας χάραξης και βάθους 
Αφού ολοκληρώσετε τις προηγούμενες ρυθμίσεις, κάντε κλικ στο πλήκτρο δίπλα 
στο παράθυρο ρυθμίσεων (όπως φαίνεται στην εικόνα). 
Στο παράθυρο που ανοίγει, μπορείτε να ρυθμίσετε: 

• Engraving speed (ταχύτητα χάραξης) 
• Engraving energy (ισχύς / ένταση του λέιζερ) 
• Engraving size (μέγεθος χάραξης) 

       Προτάσεις 
• Αν χρησιμοποιείτε κοινά υλικά, η προτεινόμενη ταχύτητα είναι ≤ 3000 

mm/min. 
• Η μέγιστη ισχύς προσαρμόζεται ανάλογα με το υλικό και την αντοχή του. 

Για παράδειγμα: 
o Τα λέιζερ M1, M2 και M3 έχουν διαφορετικές τιμές ισχύος. 
o Τα λέιζερ M4–Μ6 έχουν άλλες προτεινόμενες ρυθμίσεις. 

Σε γενικές γραμμές: 
• Υψηλότερη ισχύς → βαθύτερη χάραξη / κοπή 
• Μικρότερη ισχύς → λεπτομέρεια και καθαρότητα 

Η επιλογή εξαρτάται από: 
• το υλικό, 
• το πάχος, 
• την ποιότητα της εικόνας, 
• και τον τύπο του λέιζερ που χρησιμοποιείτε. 

Όταν ολοκληρωθούν οι ρυθμίσεις: 
Κάντε κλικ στο “Create!” για να δημιουργήσετε το G-code. 
(Οι εικόνες δείχνουν τα μενού "Engraving settings", "Power", "Speed", "Size".) 
 
 
 
 
 
 
 
 



6. Ρύθμιση εστίασης λέιζερ (Laser focus adjustment) 
Η ποιότητα χάραξης ή κοπής εξαρτάται σε μεγάλο βαθμό από το αν το λέιζερ είναι 
σωστά εστιασμένο. 
Αν η εστίαση δεν είναι σωστή, η δέσμη δεν θα έχει την απαιτούμενη ένταση και 
το αποτέλεσμα θα είναι αδύναμο, ασαφές ή με κακή καθαρότητα. 
Για σωστή λειτουργία: 

• Το λέιζερ πρέπει να εστιάζεται πάντα σε σταθερή απόσταση από την 
επιφάνεια εργασίας. 

• Η εστίαση γίνεται χειροκίνητα, κουνώντας την κεφαλή του λέιζερ πάνω-
κάτω μέχρι να επιτευχθεί η μέγιστη ισχύς. 

Για να απλοποιηθεί η διαδικασία, η συσκευή συνοδεύεται από πλαστικό κομμάτι 
σταθερής εστίασης (fixed-focus piece). 
Με αυτό το εργαλείο, μπορείτε να ρυθμίσετε την απόσταση χωρίς δοκιμές. 
Οι αποστάσεις εστίασης διαφέρουν ανάλογα με την ισχύ του λέιζερ: 

• Λέιζερ 5W → περίπου 30 mm 
• Λέιζερ 10W → περίπου 50 mm 
• Λέιζερ 20W → περίπου 60 mm 

(Οι εικόνες δείχνουν τοποθέτηση του κομματιού σταθερής εστίασης και το 
σημείο εστίασης στο λέιζερ.) 

 
B. Βήματα ρύθμισης 

1. Τοποθετήστε το κομμάτι σταθερής εστίασης πάνω στο υλικό που θα 
χαραχθεί. 

2. Κατεβάστε το λέιζερ μέχρι η κάτω πλευρά του να ακουμπήσει το κομμάτι 
εστίασης. 
Αυτό καθορίζει την ακριβή απόσταση. 

 
C. Στερέωση της θέσης του λέιζερ 

• Χρησιμοποιήστε τις δύο βίδες στη δεξιά πλευρά της βάσης του λέιζερ. 
• Αφήστε το λέιζερ να γλιστρήσει ελεύθερα προς τα κάτω μέχρι να 

ακουμπήσει το κομμάτι εστίασης. 
• Η εικόνα δείχνει το χέρι να ρυθμίζει την απόσταση. 

 
D. Σφίξιμο των βιδών 

• Σφίξτε τις δύο βίδες για να σταθεροποιήσετε τη θέση του λέιζερ. 
• Βεβαιωθείτε ότι το λέιζερ δεν κινείται πλέον πάνω-κάτω. 

 
E. Αφαίρεση του κομματιού εστίασης 

• Αφαιρέστε το πλαστικό κομμάτι σταθερής εστίασης. 
• Η ρύθμιση της εστίασης έχει ολοκληρωθεί. 

(Η εικόνα δείχνει την αφαίρεση του κομματιού και το τελικό πάχος της μεμβράνης 
σταθερής εστίασης.) 
 
 
 
 
 



7. Τοποθέτηση (Positioning) 
A. Ο χαράκτης δεν γνωρίζει πού ακριβώς πρέπει να χαράξει. 
Πριν ξεκινήσει η χάραξη, είναι πολύ σημαντικό να γίνει σωστή τοποθέτηση. 
Η διαδικασία γίνεται σε τρία βήματα. 

 
B. Πατήστε το κουμπί “Move to Center” 

• Ο χαράκτης θα μετακινηθεί στο κέντρο του σχεδίου. 
• Η χάραξη θα γίνει στο σημείο που βρίσκεται κάτω από το λέιζερ. 

(Η εικόνα δείχνει Step 1: Move to Center) 
 

C. Πατήστε το κουμπί “Light Laser” 
• Το λέιζερ θα εκπέμψει ένα ασθενές φως. 
• Το σημείο που ακουμπά το φως στο υλικό είναι το κέντρο του σχεδίου. 
• Με βάση αυτό, μετακινήστε το αντικείμενο ώστε η χάραξη να γίνει στο 

επιθυμητό σημείο. 
(Η εικόνα δείχνει Step 2: Light Laser) 

 
D. Πατήστε το κουμπί “Profile Scan” 

• Το λέιζερ θα “σκανάρει” την εξωτερική γραμμή (περίγραμμα) του 
σχεδίου. 

• Στον υπολογιστή θα εμφανιστεί το περίγραμμα. 
• Με αυτόν τον τρόπο μπορείτε να επιβεβαιώσετε αν η χάραξη θα γίνει 

ακριβώς στο σωστό σημείο. 
Επιπλέον: 

• Μπορείτε να πατήσετε το κουμπί “Frame-around” (περίγραμμα) πολλές 
φορές, 
μέχρι το περίγραμμα να τοποθετηθεί σωστά πάνω στο αντικείμενο. 

(Η εικόνα δείχνει Step 3: Profile Scan) 
 

8. Έναρξη και Τερματισμός χάραξης ή κοπής 
1. Έναρξη 
Αφού ολοκληρώσετε όλες τις προηγούμενες ρυθμίσεις: 

• Πατήστε το πράσινο κουμπί Start για να ξεκινήσει η χάραξη. 
• Δίπλα στο κουμπί υπάρχει μπάρα που δείχνει την πρόοδο της εργασίας. 

Η λειτουργία αυτή είναι χρήσιμη όταν γίνεται: 
• συνεχής χάραξη 
• κοπή με ομοιόμορφες γραμμές 
• ή οποιαδήποτε εργασία μεγάλης διάρκειας 

(Η εικόνα δείχνει Picture 1: Start) 
 

2. Τερματισμός 
Αν θέλετε να σταματήσετε τη διαδικασία στη μέση: 

• Πατήστε το κόκκινο κουμπί Stop. 
(Η εικόνα δείχνει Picture 2: Stop) 
 
 

 



9. Οδηγός εγκατάστασης LightBurn 
Μπορείτε να κατεβάσετε το LightBurn από: 
     https://lightburnsoftware.com/ 
(Εμφανίζεται το Picture 3: LightBurn installation package) 

 
Βήματα εγκατάστασης 

1. Κάντε διπλό κλικ στο αρχείο εγκατάστασης. 
2. Πατήστε “Next” στο παράθυρο που εμφανίζεται. 

(Εικόνα: Picture 4) 
Σημείωση: 
Το LightBurn είναι επί πληρωμή λογισμικό. Για καλύτερη εμπειρία συνιστάται η 
αγορά του. 
Στις εικόνες γίνεται επίδειξη της δοκιμαστικής έκδοσης (trial). 

 
Ενεργοποίηση δοκιμαστικής έκδοσης 
Βήμα 1: Επιλογή δοκιμής (Choose a free trial) 
(Εικόνα: Picture 5) 
Βήμα 2: Εύρεση του λέιζερ (Click “Find My Laser”) 
(Εικόνα: Picture 6) 
Το LightBurn θα εντοπίσει αυτόματα τον χαράκτη και θα τον προσθέσει. 
 
Ρύθμιση Σημείου Αφετηρίας 
Μετά την επιλογή “Find My Laser”, επιλέξτε τον τύπο του GRBL λέιζερ και 
πατήστε “Add Device” 
(Εικόνα: Picture 7) 
Για να ορίσουμε την αρχή (origin), συνήθως επιλέγουμε πάνω αριστερά (front 
left). 
(Εικόνα: Picture 8) 
Αν ο υπολογιστής δεν μπορεί να συνδεθεί με το μηχάνημα: 

• δοκιμάστε να επιλέξετε κάποια διαφορετική θύρα επικοινωνίας του 
λέιζερ, 

• όπως φαίνεται στην εικόνα. 
Αν συνεχιστεί το πρόβλημα, επικοινωνήστε με την τεχνική υποστήριξη. 

 
Μέρος 7: Τεχνικές χρήσης του μηχανήματος 

1. Όσο πιο κοντά είναι το λέιζερ στο τραπέζι, τόσο πιο ασταθής γίνεται η 
κατασκευή. 
Κατά τη χρήση του λέιζερ, προσπαθήστε να το ανεβάζετε στην υψηλότερη 
δυνατή θέση. 

2. Τοποθέτηση του σχεδίου και του αντικειμένου χάραξης: 
o Μετακινήστε το λέιζερ προς το κάτω μέρος του πλαισίου. 
o Χρησιμοποιήστε χάρακα και μολύβι για να σχεδιάσετε ένα 

κεντρικό σημείο στο αντικείμενο. 
(Picture 1) 

3. Η προστατευτική ασπίδα πρέπει να είναι παράλληλη με το αντικείμενο. 
(Picture 2) 

https://lightburnsoftware.com/


4. Πατήστε τα κουμπιά τοποθέτησης με τη σειρά, έτσι ώστε το λέιζερ να 
μετακινηθεί στο κέντρο της χάραξης. 
Όταν ολοκληρωθεί η τοποθέτηση, μπορείτε να ξεκινήσετε τη χάραξη. 

(Picture 3: Center point positioning) 
 

Μέρος 8: Οδηγίες συντήρησης και προειδοποιήσεις 
Το προϊόν αυτό έχει ενσωματωμένο και συμπαγή σχεδιασμό, οπότε δεν απαιτεί 
συχνή συντήρηση. 
Ωστόσο, σε περίπτωση που χρειαστεί επισκευή ή προσαρμογή, προσέξτε τα 
παρακάτω: 
1. Αποσυνδέστε την τροφοδοσία 
Πριν αγγίξετε οτιδήποτε στο λέιζερ, βεβαιωθείτε ότι έχει διακοπεί η παροχή 
ρεύματος. 
2. Αν χρειαστεί να ρυθμίσετε το λέιζερ: 

• Όλο το προσωπικό πρέπει να φορά προστατευτικά γυαλιά OD5+. 
• Βεβαιωθείτε ότι δεν υπάρχουν εύφλεκτα ή εκρηκτικά υλικά γύρω. 
• Η θέση και η κατεύθυνση του λέιζερ πρέπει να είναι σταθερές ώστε να 

μη χτυπήσει κατά λάθος: 
o άτομα, 
o ζώα, 
o εύφλεκτα αντικείμενα, 
o ή πολύτιμα αντικείμενα. 

• Μην κοιτάτε ποτέ απευθείας το λέιζερ. 
• Μην στοχεύετε το λέιζερ σε αντικείμενα με επιφάνεια καθρέπτη — η 

αντανάκλαση μπορεί να προκαλέσει τραυματισμό. 
 

3. Καθαρισμός της μονάδας λέιζερ 
Μετά από περίοδο χρήσης, ενδέχεται να συγκεντρωθούν: 

• σκόνη, 
• υπολείμματα καπνού, 
• στάχνη, 
• και άλλα σωματίδια 

στην προστατευτική ασπίδα ή στο κάλυμμα του λέιζερ. 
      Αυτά τα υπολείμματα μπορούν να επηρεάσουν την απόδοση. 
Πρέπει να καθαρίζονται έγκαιρα. 
     Πριν τον καθαρισμό, αφαιρέστε την προστατευτική ασπίδα. 
 
 
 
 
 
 
 
 
 
 

 



Μέρος 9: Λίστα αξεσουάρ 
1. Εγχειρίδιο χρήστη ×1 
2. Προστατευτικά γυαλιά ×1 
3. Καλώδιο επικοινωνίας USB ×1 
4. Βούρτσα καθαρισμού ×1 
5. Τεμάχιο σταθερής εστίασης ×1 
6. Κλειδί M5 ×1 
7. Τροφοδοτικό ×1 
8. Προσαρμογέας ισχύος ×1 

Βίδες 
• M5×25mm ×4 
• M5×8mm ×4 
• M5×14mm ×6 
• M5×16mm ×4 
• M5×12mm ×3 

Καλώδια 
• 10 βίδες/δεματικά ×1 
• Καλώδιο 16 ×1 
• 1.5/2.5/3mm εξάγωνο κλειδί ×1 για το καθένα 
• Κλειδί 10mm ×1 
• Βίδα 8mm ×1 
• Γωνιακό κλειδί 17mm ×1 
• Βύσμα ακροφυσίου ×1 

 
 
Μέρος 10: Προφυλάξεις για συνήθη προβλήματα 

1. Επιλέξτε τη σωστή θύρα COM για τη σύνδεση του λογισμικού και του 
εξοπλισμού. 
Η ταχύτητα baud πρέπει να είναι: 115200. 
Βεβαιωθείτε ότι η σύνδεση μεταξύ υπολογιστή και καλωδίου USB είναι 
σταθερή και δεν έχει χαλαρώσει. 
Αν χρειάζεστε βοήθεια στη ρύθμιση του λέιζερ, ζητήστε υποστήριξη. 

2. Πριν τη χάραξη, ελέγξτε αν κάποιος μηχανισμός είναι χαλαρός, όπως: 
o ο σύγχρονος ιμάντας, 
o ο εκκεντρικός τροχός, 
o ο κύλινδρος, 
o ή η κεφαλή του λέιζερ. 

Αν κάποιο από αυτά είναι χαλαρό ή κινείται, πρέπει να σφιχτεί. 
3. Ρυθμίστε σωστά την εστίαση και επιβεβαιώστε ότι η απόσταση από το 

κάτω μέρος της προστατευτικής ασπίδας μέχρι το υλικό είναι αυτή του 
κομματιού σταθερής εστίασης (fixed-focus film). 

4. Το λογισμικό LaserGRBL / LightBurn μπορεί να ανατρέξει στον πίνακα 
παραμέτρων της αντίστοιχης ενότητας για ρυθμίσεις χάραξης και κοπής 
για διαφορετικά υλικά. 
Η χάραξη αντικειμένων με επιφάνεια καθρέπτη απαιτεί χειροκίνητο 
μαύρισμα της επιφάνειας (blackening treatment). 


